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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

A note provides important related information, reminders,
recommendations, and strong suggestions.

& A caution means that a specific action you take could cause harm to
your computer or cause you to lose data.

@ A warning describes an action that could cause you physical harm.
Follow the guidelines in this document or on the unit itself when
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the
order you select them. For example, File > Import means to open the
File menu and then select the Import command.

b This symbol indicates a single-step procedure. Multiple arrows in a list
indicate that you perform one of the actions listed.



If You Need Help

Symbol or Convention Meaning or Action

(Windows), (Windows This text indicates that the information applies only to the specified

only), (Macintosh), or operating system, either Windows or Macintosh OS X.
(Macintosh only)
Bold font Bold font is primarily used in task instructions to identify user interface

items and keyboard sequences.
Italic font Italic font is used to emphasize certain words and to indicate variables.
Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action  Press and hold the first key while you press the last key or perform the
mouse action. For example, Command+Option+C or Ctrl+drag.

If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is
especially important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after the
documentation was published. Also check online for the most up-to-date ReadMe because
the online version is updated whenever new information becomes available. To view the
online ReadMe, select ReadMe from the Help menu, or visit the Knowledge Base at
http://www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for
maintenance or hardware-related issues. In addition to the printed documentation supplied
with your editing application, the documentation is supplied in PDF format when you install
the application. Topics that you print from the Help have limited page layout and formatting
features. If you want to print a higher quality version of Help information, Avid recommends
that you print all or part of the PDF version of the appropriate Avid manual included in the
Online Library for your editing application. To access the Online Library, select Help >
Online Library from within your Avid editing application.

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 24
hours per day, 7 days per week. Search the Knowledge Base to find answers, to view error
messages, to access troubleshooting tips, to download updates, and to read or join online
message-board discussions.


http://avid.force.com/pkb/articles/en_US/readme/Media-Composer-Software-8-0-Documentation
http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport

New in Media Composer v2018.5

New in Media Composer v2018.5

New Features: For information on new features, see the What’s New v2018.5.

The “Run Length Encoding for Alpha on Import” feature that was implemented in the
previous release (v2018.4) has been temporarily disabled for this release.

Qualified Operating Systems: For information on qualified operating systems, see
Qualified Hardware and Operating Systems.

Dongle Info (Mac Only): The Dongle Sentinel driver installer is no longer automatically
installed when you install the editing application. The driver is now located in the
Avid_Utilities folder (/Applications/Utilities/Avid_Ultilities/Sentinel_Driver). If you have a
dongle, manually install the driver from this location.

When installing the Sentinel Driver, check your System Preferences and select “Security
and Privacy.” You may need to choose to Allow the driver to be accessed.

NVIDIA Driver: The editing application supports Nvidia Driver v390.77.

If you have a Quadro 4000 graphics card remain on the Nvidia v353.82 driver.

Avid recommends that if you are on a Windows 7 system and working with the v390.77
Nvidia driver, you should enable desktop composition. See this article for details:

http://avid.force.com/pkb/articles/en_US/how_to/Enable-Desktop-Composition-in-Window
s-7

DX Driver installed separately: Starting with Media Composer v8.9.4, the DX Driver was
not automatically installed on Mac systems. With this release, the DX Driver is not
automatically installed on Windows systems. See Avid DX Driver Separate Installer.

Fixed in Media Composer v2018.5

The following have been fixed:

»  Bug Number: MCCET-2437. AMA Export File Insert Edit did not work unless you selected all
tracks in the sequence or clip.

»  Bug Number: MCCET-2211. In some instances, you might have heard audio corruption on
XDCAM linked media.

»  Bug Number: MCCET-2362. (Interplay) Sometimes Color Correction presets were
inadvertently checked in.


http://avid.force.com/pkb/articles/en_US/how_to/Enable-Desktop-Composition-in-Windows-7
http://avid.force.com/pkb/articles/en_US/how_to/Enable-Desktop-Composition-in-Windows-7
http://avid.force.com/pkb/articles/en_US/User_Guide/Media-Composer-2018-Documentation

Fixed in Media Composer v2018.5

Bug Number: MCCET-2431. If you performed a Clear Bin Memory, the Color Correction
Presets category no longer appeared in the Effect Palette.

Bug Number: MCCET-2354. In some instances, after rendering a Compressor/Limiter effect,
some of the audio no longer plays.

Bug Number: MCCET-2345. If you mapped the “To the right” button from the Command
Palette Edit tab to the keyboard, that mapped button did not behave the same as choosing Select
> To the right from the Timeline context menu.

Bug Number: MCCET-2364. After relaunching the editing application, the Audio Suite render
Drive defaulted to C drive regardless of Media Creation Settings.

Bug Number: MCCET-2402. In some instances, an MXF OP-atom file displayed as a linked
video file when it was actually an imported file. Selecting the file might have resulted in an
Exception error.

Bug Number: MCCET-2421. In some instances, the editing application would crash if you
exported AAF Embedded Audio-only AIFF-C media.

Bug Number: MCCET-2399. The file extension did not always change when you modified
Export settings.

Bug Number: MCCET-2248. Occasionally, you might have seen playback jitter when creating
XDCAM HD 50 media.

Bug Number: MCCET-2429. After clearing the Source monitor, marker comments might have
been missing from the Source monitor on audio only clips.

Bug Number: MCCET-2394. In some instances, a crash report window would display after you
opened the Media Creations Settings.

Bug Number: MCCET-2349. In some instances, synced clips were corrupted when audio was
relinked.

Bug Number: MCCET-2398. When working with the Timecode Burn-In effect, you could not
select tracks higher than 24.

Bug Number: MCCET-2348. (Avid DNxIO) In some instances, Audio meters did not work
when scrubbing with Caps Lock on.

Bug Number: MCCET-2032, DMAN-2217. A Chroma Sub Sampling column has been added
that will display the sub sampling rate for media.
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Fixed in Media Composer v2018.5

Bug Number: MCCET-2420. SDI Embedded DVITC output stopped when you opened the
Audio Mixer Tool.

Bug Number: MCCET-2396. In some instances, the Reduce/Enlarge buttons did not work
properly in the Effect Editor.

Bug Number: MCCET-2434. The Marker window did not display correctly after you printed
markers.

Bug Number: MCCET-2436. The Marker window did not always display the correct markers
from the selected Source/Record window. For example, even if you selected the Source window,
the Marker window displayed the Record markers.

Bug Number: MCCET-2352. In some instances, after transcoding a clip, the ARRI LUT was
not applied correctly.

Bug Number: MCDEV-8300. After performing a mixdown, the target bin you selected in the
Video Mixdown window was no longer selected when you returned again to the Video Mixdown
window.

Bug Number: MCDEV-9105. In some instances, even when Show Tooltips was deselected in
the Interface settings, tooltips still appeared.

Bug Number: MCDEV-9124, MCCET-2435. In some instances, clicking the Markers button at
the bottom left of the create Marker window, opened an old style version of the Marker Tool
window.

Bug Number: MCDEV-9122. With the blue bar positioned over a marker in the active
Composer monitor, opening the Marker Tool did not scroll to and highlight that marker's row.

Bug Number: MCCET-2200. Even after XDCAM clips were consolidated, they would relink
back to the removal media drive once the removable drive was browsed again.

Bug Number: MCCET-2314. (Media Composer | Cloud) In some instances, the editing
application crashed after a remote download finished when you relinked to the downloaded
media.

Bug Number: MCCET-2372. When creating an XML output from the List Tool, the Marker
data was incorrect for Opticals if you had effects on clips.

Bug Number: MCCET-2366. You might have received a “Standard Exception” error when
transcoding linked AVCHD clips.



Limitations

»  Bug Number: MCCET-2356. The Media Creation window did not remember the last tab
selected.

»  Bug Number: MCCET-2333. You might have seen artifacts on the first frame when linking
AS-11 clips created by 3rd party application ContentAgent.

»  Bug Number: MCCET-2340. Instead of a non descriptive error appearing, you will receive a
“Warning: Some of the tracks are locked” when trying to edit into a locked track.

»  Bug Number: MCCET-2346. The first result in the Find window was not automatically
highlighted.

»  Bug Number: MCCET-2376. (Mac) The editing application exited from Full Screen Play when
you saved changes.

»  Bug Number: MCCET-2385. In some instances, after using some keyboard shortcuts, there
would be incorrect focus to the Source/Record monitors.

»  Bug Number: MCCET-2406. Focus in the User Interface was not correct after entering a
comment on a marker and then exiting the Marker Window with the Enter key on the numeric
keypad.

> Bug Number: MCCET-2252. With the release of Mac OS v10.13.x (High Sierra), Media
Composer could not write (i.e. capture, import, render) to the system drive.

Limitations

»  Bug Number: MCDEV-9269. (Media Composer | Cloud) After performing a remote download
operation on a sequence containing AVC-I 100 remote media, the downloaded media appears as
XAVC-I 100.

Workaround: Download the entire master clips.

»  Bug Number: MCDEV-9138. You cannot open multiple bins at the same time from the
Finder/Desktop.

»  Bug Number: (Mac). You may occasionally see the menu bar flash followed by a brief beach

ball. To fix this, deactivate “Displays have separate spaces” under System Preferences > Mission
Control settings.



Before Installing the Editing Application

Bug Number: MCDEV-9011. Intermittently, when working with the XDCAM Nablet Plug-in,
you might see “Failed to get the sample position from the AMA Plug-in” errors if you have
waveforms enabled in the Timeline.

Bug Number: COGS-2560. While working in the Script Window, text operations
(cut/copy/paste/delete/editing) can only be done in edit mode. See “Editing a Script” in the Help.

Bug Number: MCDEV-5650. When working with Panasonic LongG media, you might receive
an “SFPlayConsumer Timeout” error if audio waveforms are enabled.

Workaround: Turn off audio waveforms.

Bug Number: MCDEV-5385. Multicam editing with Panasonic LongG media is not supported
with this release.

Bug Number: MCDEV-5384. Currently, when working with LongG media, you might see
dropped frames when editing 4 streams. This might occur when playing from a single stream to
multiple streams (and from multiple streams back to a single stream). The dropped frames
usually display around the edit point (transition to a different stream).

Before Installing the Editing Application

A

Avid DX Driver Separate Installer

The Avid DX Driver is not automatically installed when you install the editing application. If
you need to install the Avid DX Driver to work with your Avid IO device, you can install it
separately.

The installer is located:
*  (Mac) /Applications/Utilities/Avid Utilities
*  (Windows) Program Files\Avid\Utilities\DXDrivers

For Windows systems, there is a Win7 driver and a Winl0 driver in the Utilities folder. The Win7
driver works for both Windows 7 and Windows 8 systems.

Before Installing the Editing Application in an Avid Interplay Environment

Please note the following before you install the editing application in an Avid Interplay
environment.

Media Composer v8.7 and higher requires Avid Interplay client v3.7 and higher.



Before Installing the Editing Application

Upgrading to Mac OS v10.11.x

(Mac) If you upgrade to Mac OS 10.11.x, you must uninstall Media Composer. Reinstall Media
Composer after you perform the OS upgrade. If you use Avid Artist DNxIO, you must also
uninstall the Desktop Video software and reinstall it after the OS upgrade.

Installation Information

Read through the Installation Guide for Avid Editing Applications. This document is available on
the Knowledge Base.

If you are upgrading from v7.x to v8.x, you must uninstall the Avid Transcode Service and the
Avid Editing application. Beginning with version 8.0 of the editing application, the Transcode
Service is included as part of the editing application and is no longer a separate program. When
you uninstall Media Composer v8.0, a separate uninstall of Transcode service is no longer
necessary.

Buffer Error Message

The editing application requires a minimum of 8GB RAM. If you try to install the editing
application on a system with less than 8GB RAM, you will receive a buffer error and installation
will not proceed.

Sentinel Error Message

(MCDEV-2394) On a Windows 7 system, if a “Failed to add Sentinel64.cat file.” error appears
during the installation, you can safely click OK to continue with the installation. Dongle
activation will work properly.

Download Note

To avoid “File Path too long” or a “File cannot be copied” warning while unzipping the
downloaded installer, try placing the installer .zip on the root level of your C:\ drive and unzip it
from that location.

User Right to Raise Thread Priority

(Windows) Note for Domain Administrators: If your editing systems are part of a domain, you
must give the user the right to “Increase Scheduling Priority.” This must be done within the
Domain Group Policy on the domain controller by giving the right explicitly to the user or giving
the right to a group and adding the user to that group. You will not be able to launch as a regular
user if this is not set properly.

If you are part of a domain, a Domain Administrator should install and perform the first launch
of the editing application.



After Installing the Editing Application

Install as Administrator

You need to first install and launch the editing application as an Administrator. If you are in a
Shared Storage environment, mount your workspaces as an Administrator. You may then log off
and log back in as a Standard user, if necessary.

After Installing the Editing Application

AMA Plug-Ins

You cannot install the AMA Plug-ins while the editing application background services are
running. Make sure you Stop the services before installing the AMA Plug-Ins. The stop/start
background services icon is on the menu bar (Macintosh) or taskbar (Windows). Once you install
the new AMA plug-in, restart the services. See “Starting and Stopping Avid Background
Services” in the Help.

Notes on Software Licensing

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, first
deactivate your software. After you upgrade your operating system and, if required, reinstall
your application, you can reactivate your software. For information on activating and
deactivating your software license, see the Installation Guide for Avid Editing Applications.

Minimum RAM Recommendation

For this release Avid recommends a minimum of 8 GB of RAM. Some features might require
more RAM and specific hardware. See “Feature Performance” on page 27 for more info.

Qualified Hardware and Operating Systems

Some features are processor-intensive and require specific hardware. See “Feature Performance”
on page 27 for more info.

The following tables provide the information on qualified Windows and Macintosh hardware.

For 3rd-Party Open 10 hardware qualification refer to the manufacturer’s documentation. See the
Open 10 Frequently Asked Questions document on the Knowledge Base:
http://avid.force.com/pkb/articles/en_US/faq/en422991
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Qualified Hardware and Operating Systems

The following lists the qualified Operating Systems. Depending upon your hardware the
qualified Operating Systems are:

*  Windows v7 64-bit SP1(Professional) and Windows v8.1 (Professional and Enterprise),
Windows v10 64-bit (Professional, Creators, and Enterprise).

*  Macintosh v10.10.5, 10.11.6, 10.12.6, 10.13.4

With the release of Mac OS v10.13.x (High Sierra), Apple requires manual approval of loading
Kernel Extensions (KEXTs). (For example Avid Nitris DX, BlackMagic, and AJA IO devices
install Kernel Extensions.) At installation time, you should get a dialog saying that the KEXT
was not loaded. You must go the “Security & Privacy” system preference and manually approve
the KEXT. Keep the Security & Privacy pane open after you install the I/O device drivers so that

you will see the notice that the driver has been blocked and press the “allow” button within 30
minutes of installing or the driver will be permanently blocked.

Macintosh OS Permission Information

As of Macintosh OS 10.7 Lion, the default permissions for the root level of the system drive are
now set to “Read Only” for all users. This prevents the Avid editing application from being able
to use this drive as a media drive. You will see the drive grayed out in Media Creation settings or
as an option for import, mixdown, render, and consolidate/transcode.

If you don’t intend to use the system drive for media you can leave it alone. This is ideal in most
cases.

If you do need to use the system drive, perform the following to change permissions.

To change permissions:
1. Click on your system drive (Macintosh HD in most cases) to highlight.
2. From the File menu select Get Info (cmd+I).
3. Click the lock icon in the bottom right to make changes.
4

. Click on the “Read only” text in the Privilege column next to Everyone and set the privilege
to “Read & Write.”

You should now be able to see the system drive as a valid media drive.

If you repair permissions on the system drive, they will reset and you will have to repeat this
procedure.
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Qualified Hardware and Operating Systems

Qualified Workstations and Laptops

The following tables list the qualified workstations and laptops for Media Composer editing
applications.

Qualified PC Workstations with Avid Media Composer
The following PC Workstations are qualified with Avid Media Composer.

Avid Artist DNxIV requires a Thunderbolt 2 or 3 card. See details here.

Qualified PC Hardware Graphics Card Supported with
HP Z8 G4 Dual [8 - 24 core 2.1 Ghz or higher] Nvidia P4000, Avid Artist DNxIO
scalable P5000, P6000 Avid Artist DNXIQ
64-128 GB DDR4-2666 memory, Tower AMD WX7100

HP Z6 G4 Dual [8 -24 core 2.1 Ghz or higher]  Nvidia P4000, Avid Artist DNxIO
Intel Scalable Processors P5000, Avid Artist DNxIQ
64 to 192GB DDR4-2666 memory AMDWX7100

HP Z4 G4 6 - 10 core or 18 core 3.3 Ghz or Nvidia P2000, Avid Artist DNxIO
higher processor P4000 Avid Artist DNxIQ
32-128 GB DDR4-2666 memory, Tower AMD

WX5100,WX7100

Dell 7920 Dual (8-24 core 2.1 GHz or higher)  Nvidia P4000 P5000 Avid Artist DNxIO
Intel Scalable Processors Tower P6000 Avid Artist DNxIQ
64 to 128 GB DDR4-2666 memory AMD WX7100 Avid Artist DNxIV

Dell R7920 Dual (8-24 core 2.1 GHz or higher) Nvidia P4000 P5000 Avid Artist DNxIO
Intel Scalable Processors Rack P6000 Avid Artist DNxIQ
64 to 128 GB DDR4-2666 memory AMD WX7100

Thunderbolt adapter not supported in Rack 7920

Dell 7820 Dual (8-24 core 2.1 GHz or higher)  Nvidia P4000 P5000 Avid Artist DNXIO

Intel Scalable Processors AMD Avid Artist DNxIQ
64 to 128 GB DDR4-2666 memory WX7100 Avid Artist DNxIV
Dell 5820 6, 8 or 10 core 3.3 Ghz or higher Nvidia P600, P1000 Avid Artist DNxIO
Intel W-Processors P2000 Avid Artist DNxIQ
32 to 128 GB DDR4-2666 memory Avid Artist DNxIV
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http://avid.force.com/pkb/articles/en_US/Compatibility/DX-DNxIO-connection-chart

Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Lenovo P920 Dual [8 -28 core 2.1 Ghz or
higher] Intel Scalable Processors
64 to 192 GB DDR4-2666 memory

HP Z240 3.0 Ghz or higher quad core i7/Xeon
E3 8 to 64 GB DDR4-2400 memory Tower or

SFF

HP Z2 Mini 3.0 Ghz or higher quad core
i7/Xeon E3 § to 32 GB 2400Mhz DDR4

Memory, USB-C

Dell 3620 3.0 Ghz or higher quad core i7/Xeon
E3 8/16/32 GB DDR4-2400 memory Tower

Dell 3420 3.0 Ghz or higher quad core i7/Xeon
E3 8/16/32 GB DDR4-2400 memory SFF

Dell 5720 AIO 3.3 Ghz or higher quad core
i7/Xeon E3 3840x2160 - 8 to 64 GB 2400Mhz
DDR4 Memory, thunderbolt 3/USB-C

Lenovo P720 Dual [8 -28 core 2.1 Ghz or
higher] Intel Scalable Processors
64 to 192 GB DDR4-2666 memory

Lenovo P520/P520C 6, 8, 10 or 18core 2.3 Ghz
or higher] Intel W-Processors
32 to 128 GB DDR4-2666 memory

Lenovo P320 3.0 Ghz or higher quad core
i7/Xeon E3 8/16/32 GB DDR4-2400 memory

Tower or SFF

Nvidia P4000
P5000, P6000

Nvidia K1200
(SFF), P2000
(Tower)

Intel P630

Nvidia M620,
HD530, HD630

Nvidia M2000,
M4000

Intel P630

Nvidia K620, K1200
Intel P630

AMD WX4150

NvidiaP2000, P4000
P5000

Nvidia P1000,
P2000 P4000

Nvidia P600, P1000
P2000(Tower)
Intel P630

Lenovo P320 Tiny 2.9 GHz quad core i7-7700T Nvidia P600
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Avid Artist DNxIO
Avid Artist DNxIQ

Software Only

Software Only

Software Only

Software Only

Software Only
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Avid Artist DNxIO
Avid Artist DNxIQ

Avid Artist DNxIO
Avid Artist DNxIQ

Software Only

Software Only



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

HP Z840 Dual [8 - 16 core 2.1 Ghz or higher]
Intel V4 32/64 GB DDR4 2400 memory

HP Z640 Dual 10, 12, 16 core 2.1 Ghz or
higher] Intel V4 32/64 GB DDR4-2400 memory

Dell 7910 Dual [8 - 16 core 2.1 Ghz or higher]
Intel V4 32/64 GB DDR4-2400 memory

Dell R7910 Dual [8 - 16 core 2.1 Ghz or higher]
Intel V4 32/64 GB DDR4-2400 memory

Dell 7810 Dual [8-16 core 2.1 Ghz or higher]
Intel V4 32/64 GB DDR4-2400 memory

Dell 5810 [6 or 8 core 3.0 Ghz or higher] Intel
V4 16/32/64 GB DDR4- 2400 memory
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Nvidia P4000,
P5000, P6000,
M4000, M5000,
M6000

AMD W7100,
WX7100

Nvidia P4000,
P5000, P6000
M2000, M4000
M5000, M6000

AMDWS5100,
W7100, W8100

Nvidia M4000,
M5000, M6000

AMD W7100,
W8100

Nvidia M4000,
M5000, M6000

AMD W7100,
W38100

Nvidia M2000,
M4000, M5000

AMD W5100W,
W7100, W8100

Nvidia M2000
AMD W5100

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNXIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Lenovo P910 Dual [8 - 16 core 2.1 Ghz or
higher] Intel V4 32/64 GB DDR4-2400 memory

Lenovo P710 Dual [8 - 16 core 2.1 Ghz or
higher] Intel V4 32/64 GB DDR4-2400 memory

HP Z440 [6 or 8 core 3.0 Ghz or higher] Intel
V4 16/32/64 GB DDR4- 2400 memory

Lenovo P510 6 or 8 core 3.0 Ghz or higher Intel
V4 16/32/64 GB DDR4- 2400 memory

HP 7840 Dual 8, 10 or 12 core Intel V3 2.3 Ghz
or higher Onboard NIC supported for ISIS 32 or
64 GB DDR4- 2133 memory

HP Z640 Dual 8, 10 or 12 core Intel V3 2.3 Ghz
or higher 32/64 GB DDR4-2133 Memory
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Nvidia M4000,
M35000, M6000

Nvidia M2000,
M4000, M5000

Nvidia P2000,
M2000

AMD W5100

Nvidia M2000,
K1200

Nvidia K4200,
K5200, M4000,
M5000, M6000

AMD W7100,
W8100

Nvidia K2200,
K4200, K5200,
M4000, M5000

AMD, W5100,
W7100, W8100

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxXIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxXIV



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Dell R7910 Dual 8,10 or 12 Core Intel V3
2.3 Ghz or higher Onboard NIC supported for
ISIS 32 or 64 GB DDR4- 2133 memory

Dell 7910 Dual 8, 10 or 12 core Intel V3 2.3 Ghz
or higher - Onboard NIC supported for ISIS 32
or 64 GB DDR4- 2133 memory

Dell 7810 Dual 8, 10 or 12 core Intel V3 2.3 Ghz
or higher - Onboard NIC supported for ISIS 32
or 64 GB DDR4- 2133 memory

Lenovo P900 Dual 8, 10 or 12 core Intel V3 2.3
Ghz or higher - Onboard NIC supported for ISIS
32 or 64 GB DDR4- 2133 memory

Lenovo P700 Dual 8, 10 or 12 core Intel V3
2.3 Ghz or higher - Onboard NIC supported for
ISIS

32 or 64 GB DDR4- 2133 memory

HP Z240 Tower and SFF (Small Form Factor)
Quad Xeon E3- 1245V5 3.5 Ghz

Onboard NIC supported for ISIS

8/16/32 GB DDR4- 2133 Memory

Lenovo P310 Tower and SFF (Small Form
Factor) Quad Xeon E3- 1245V5 3.5 Ghz
Onboard NIC supported for ISIS

8/16/32 GB DDR4- 2133 Memory
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Nvidia K4200,
K5200, M4000,
M5000, M6000

AMD W7100,
W8100

Nvidia K4200,
K5200, M4000,
M5000, M6000

AMD W7100,
W8100

Nvidia K2200,
K4200, K5200,
M4000, M5000

AMD W5100,
W7100, W8100

Nvidia K4200,
K5200, M4000,
M5000, M6000

Nvidia, K2200
K4200, K5200,
M4000, M5000

Nvidia K620, K1200
K2200, HD530

Nvidia K620, K1200

K2200
HD530

Software Only
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxXIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only

Software Only



Qualified Hardware and Operating Systems

Qualified PC Hardware

Graphics Card

Supported with

Dell 3620 quad Xeon E3-1245V5 3.5 Ghz
Onboard NIC supported for ISIS 8/16/32 GB

HD
DDR4- 2133 Memory 530

Dell 3420 SFF (Small Form Factor) Quad Xeon Nvidia K620, K1200

E3-1245V5 3.5 Ghz

HD530
Onboard NIC supported for ISIS
8/16/32 GB DDR4- 2133 Memory
HP Z820 Dual 12 core E5-2695V2 2.4 Ghz, Nvidia K4000

Dual 8 core E5-2650V2 2.6 Ghz, or Dual 6-core
E5-2630V2 2.6 Ghz

Onboard NIC supported for ISIS

16 or 32 GB DDR3- 1866 memory (only 32 GB
RAM is supported with the Dual 12 core model)

Dell T7610 Dual 12 core E5-2695V2 2.4 Ghz, Nvidia K4000
Dual 8 core E5-2650V2 2.6 Ghz, or Dual 6- core

E5-2630V2 2.6 Ghz

Onboard NIC supported for ISIS

16 or 32 GB DDR3- 1866 memory (only 32 GB

RAM is supported with the Dual 12 core model)

Dell R7610 Dual 12 core E5S-2695V2 2.4 Ghz, Nvidia K4000
Dual 8 core E5-2650V2 2.6 Ghz, or Dual 6- core

E5-2630V2 2.6 Ghz

Onboard NIC supported for ISIS

16 or 32 GB DDR3- 1866 memory (only 32 GB

RAM is supported with the Dual 12 core

Dell T5610 Dual 12 core E5-2695V2 2.4
Ghz,Dual 8 core E5-2650V22.6 Ghz, or Dual
6-core E5-2630V2 2.6 Ghz

Onboard NIC supported for ISIS

16 or 32 GB DDR3- 1866 memory (only 32 GB
RAM is supported with the Dual 12 core model)

Nvidia K4000

Lenovo D30 Dual 12 core E5-2695V2 2.4Ghz, Nvidia K4000
Dual 8 core E5-2650V2 2.6 Ghz , orDual 6-core

E5-2630V2 2.6 Ghz

Onboard NIC supported for ISIS

16 or 32 GB DDR3- 1866 memory (only 32 GB

RAM is supported with the Dual 12 core model)
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Nvidia K620, K2200 Software Only

Software Only

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Lenovo C30 Dual 12 core E5-2695V2 2.4 Ghz,
Dual 8 core E5-2650V2 2.6 Ghz, or Dual 6-core
E5-2630V2 2.6 Ghz

Onboard NIC supported for ISIS

16 or 32 GB DDR3- 1866 memory (only 32 GB

RAM is supported with the Dual 12 core model)

HP Z820 Dual 8 Core E5-2665 2.4 GHz or Dual
6 core E5-2640 2.5 Ghz 16GB (8x2GB) or
32GB (8x4GB) ECC Memory Only 6 core
supported in 5.5.3.6/9.5.3.6

Dell T7 600Dual 6-Core E5-2640 2.5GHz or
Dual 8-Core E5-2660 2.2 GHz

16GB (8x2GB) or 32GB (8x4GB) ECC
Memory

Lenovo D30 Dual 6 Core E5-2640 2.5GHz or
dual 8 Core E5-2660 2.2GHz

16GB (8x2GB) or 32GB (8x4GB) ECC
Memory

Dell T5600 Dual 6-Core E5-2630 2.5GHz or
Dual 8-Core 2.2 GHz

16GB (8x2GB) or 32GB (8x4GB) ECC
Memory

Lenovo C30 Dual 6- Core E5-2640 2.5GHz or
Dual 8-Core 2.2 GHz

16GB (8x2GB) or 32GB (8x4GB) DDR3- 1600
RAM
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Nvidia K4000

Nvidia Q4000,
K4000

Nvidia Q4000,
K4000

Nvidia Q4000
K4000

Nvidia Q4000
K4000

Nvidia Q4000,
K4000

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxXIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxXIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNXIV



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

HP Z440 6-core or 8 core Intel V3 3.0 Ghz or
higher

Onboard NIC supported for ISIS

16 or 32 GB DDR4- 2133 memory

Dell 5810 6-core or 8 core Intel V3 3.0 Ghz or
higher

Onboard NIC supported for ISIS

16 or 32 GB DDR4- 2133 memory

Lenovo P500 6-core or 8 core Intel V3 3.0 Ghz
or higher

Onboard NIC supported for ISIS

16 or 32 GB DDR4- 2133 memory

HP Z420 6-core E5-1650 V2 3.5 Ghz
Onboard NIC supported for ISIS
8 or 16 GB DDR3-1866 Memory

Dell T3610 6-core E5-1650 V2 3.5 Ghz
Onboard NIC supported for ISIS
8 or 16 GB DDR3-1866 Memory

Lenovo S30 6-core E5- 1650 V2 3.5 Ghz
Onboard NIC supported for ISIS
8 or 16 GB DDR3- 1866 Memory
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Nvidia K2200
AMD W5100

Nvidia K2200

AMD W5100

Nvidia K2200

Nvidia K2000

Nvidia K2000

Nvidia K2000

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxXIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxXIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNXIV



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

HP 7420 6- Core E5-1650 3.2 GHz
8GB or 16GB DDR3 1600 ECC memory

Dell T3600 6- core E5-1650 3.2GHz
8GB or 16GB ECC Memory

Lenovo S30 6-Core E5-1650 3.2 GHz
8GB or 16GB DDR3 1600 ECC memory

HP 7230 Tower and SFF (Small Form
Factor)Quad-core E3-1245v3 3.4 Ghz CPU
8 or 16 GB DDR3-1600 memory

Dell T1700 Tower Only (Small Form Factor not
supported) Quadcore E3-1245v3 3.4 Ghz CPU
8 or 16 GB DDR3-1600 memory

Lenovo P300 Tower and SFF (Small Form
Factor) Quad-Core E3- 1246v3 3.5 Ghz CPU
8 or 16 GB DDR3-1600 Memory

Lenovo E32 Tower and SFF (Small Form
Factor)Quad-Core E3- 1245v3 3.4 Ghz CPU
8 or 16 GB DDR3-1600 Memory

HP Z1 G3 3.3 Ghz or higher quad core i7/Xeon
E3

3840x2160 - 8 to 64 GB 2133Mhz DDR4
Memory, thunderbolt 3/USB-C

HP Z1 G2 All-in-one E3- 1245V3 3.4 Ghz CPU
8 or 16 GB DDR3-1600 Memory
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Nvidia Q2000,
K2000

Nvidia Q2000
K2000

Nvidia Q2000
K2000

Intel HD P4600
Nvidia K600

Nvidia K600

Intel HD 4600
Nvidia K600, K620

Intel HD 4600
Nvidia K600

Nvidia M1000M,
M2000M

Intel HD 4600

Nvidia K2100M,
K3100M, K4100M

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Nitris DX

Mojo DX

Avid Artist DNxXIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only

Software Only

Software Only

Software Only

Software Only
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV

Software Only
Mojo DX



Qualified Hardware and Operating Systems

Qualified PC Hardware Graphics Card Supported with

HP Z1 All-in-one quad coreE3 1245V2 3.4Ghz Intel HD 4000 Software Only
Nvidia Q1000M

Lenovo ThinkCentre Edge 937 17-4770S quad  Intel HD 4600 Software Only

core 3.1 Ghz

8 or 16 GB DDR3-1600 memory

Lenovo ThinkCentre Edge 92z ALL-IN-ONE  Intel HD 4000 Software Only
Quad-core i7-3770 3.1 GHz
8 or 16 GB DDR3-1600 Memory

Qualified PC Notebooks for Avid Media Composer
The following PC Notebooks are qualified with Avid Media Composer. The following applies to
the editing system when running on a laptop:

*  DNxHD capture is only supported on Mojo DX on a Quad core system with hyperthreading
enabled. Nitris DX is not supported on laptops.

*  Capture of 10 bit video for example, DNxHD 185x, is not supported on Mojo DX.
*  Playback in full quality 10 bit mode is not supported

Qualified PC Notebooks Graphics Cards Supported With
HP Zbook 17" G4 2.8 Ghz or higher quad core Nvidia Avid Artist DNxIO
i7/Xeon E3 P3000 Avid Artist DNxIQ
P4000 Avid Artist DNxIV
P5000 Mojo DX
AMD
WX4170
HP Zbook 15" G4 2.8 Ghz or higher quad core Nvidia Avid Artist DNxIO
i7/Xeon E3 M620 Avid Artist DNxIQ
M1200 Avid Artist DNxIV
M2200 Mojo DX
AMD WX4150
HP Zbook Studio Ultrabook G4 2.8 Ghz or Nvidia Avid Artist DNxIO
higher quad core i7/Xeon E3 M1200 Avid Artist DNxIQ
Avid Artist DNxIV
Mojo DX
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Qualified Hardware and Operating Systems

Qualified PC Notebooks Graphics Cards Supported With

Dell 7720 17" 2.6 Ghz or higher quad core Nvidia P3000, Avid Artist DNxIO

i7/Xeon E3 1920x1080 or 3840x2160 - 8 to P4000, P5000 Avid Artist DNxIQ

64 GB 2400Mhz DDR4 Memory, thunderbolt 3 AMD Radeon f/{v@ ADr>t(1st DNxIV
0jo

WX4150, WX7100

Dell 7520 15" 2.6 Ghz or higher quad core Nvidia M1200, Avid Artist DNxIO
i7/Xeon E3 1920x1080 or 3840x2160 - 8 to M2200 Avid Artist DNXIQ

64 GB 2400Mhz DDR4 Memory, thunderbolt 3 AMD Radeon Avi.d Artist DNxIV
WX4130, wxa150 Moo DX
Dell 5520 15" 2.8 Ghz or higher quad core Nvidia M1200 Avid Artist DNxIO
17/Xeon E3 1920x1080 or 3840x2160 - 8 to Avid Artist DNxIQ
32 GB 2400Mhz DDR4 Memory Thunderbolt 3 Avid Artist DNxIV
Mojo DX
Dell 3520 15" 2.8 Ghz or higher quad core Nvidia Avid Artist DNxIO
i7/Xeon E3 1920x1080 - 8 to 32 GB 2400Mhz M620 Avid Artist DNXIQ
DDR4 Memory - Thunderbolt 3 Avid Artist DNxIV
Mojo DX
HP Zbook Studio G4 2.8 Ghz or higher quad ~ Nvidia M1200 Avid Artist DNxIO
core 17/Xeon E3 Avid Artist DNxIQ
1920x1080 or 3840x2160 - 8 to 32 GB Avid Artist DNxIV
2400Mhz DDR4 Memory, Thunderbolt 3, Mojo DX
Ultrabook

HP Zbook 15" G3 2.6 Ghz or higher Quad core Nvidia M1000M,  Avid Artist DNxIO
17/Xeon E3 1920x1080 or 3840x2160- § to 64 M2000M, M600M Avid Artist DNxIQ

GB 2133Mhz DDR4 Memory, thunderbolt 3 Avid Artist DNxIV
AMD, W5170M Mojo DX

Intel HD 530, P530,
P580

HP Zbook 17" G3 2.6Ghz or higher quad core  Nvidia M3000M,  Avid Artist DNXIO
M4000M, M5000M  Avid Artist DNxIQ

17/Xeon E3 Avid Artist DNxTV
AMD W6150M Vid ATt DRX
Mojo DX
Intel HD 530, P530,
P580

Dell 7710 17" 2.7 Ghz quad core i7 or 2.9 Ghz Nvidia M3000M,  Avid Artist DNxIO

Xeon E3 1920x1080 or 3840x2160 - 8/16/32  M4000M, M5000M Avid Artist DNxIQ

GB 2133Mhz DDR4L Memory AMD W7170M AVl.d Artist DNxIV
Mojo DX
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Qualified Hardware and Operating Systems

Qualified PC Notebooks Graphics Cards Supported With
Dell 7510 15" 2.5 Ghz and higher quad core i7 Nvidia M1000M,  Avid Artist DNxIO
1920x1080 or 3200x1800 - 8/16/32 GB M2000M Avid Artist DNxIQ
2133Mhz DDR4L Memory AMD W5170M Av1f1 Artist DNxIV
Mojo DX
Dell 5510 15" 2.3 Ghz and higher quad core i7 Nvidia M1000M Avid Artist DNxIO
1920x1080 or 3840x2160 - 8/16 GB 2133Mhz Avid Artist DNxIQ
DDRA4L Memory USB-C Avid Artist DNxIV
Mojo DX
Dell 3510 15" 2.3 Ghz and higher quad core i7 AMD W5130M Avid Artist DNxXIO
1920x1080 - 8/16 GB 2133Mhz DDR4L Avid Artist DNxIQ
Memory Avid Artist DNxIV
Mojo DX
Lenovo P70 2.6 Ghz or higher quad core Nvidia M3000M,  Avid Artist DNxIO
i7/Xeon E3 M4000M, M5000M  Avid Artist DNxIQ
1920x1080 or 3840x2160 - 8 to 64 GB Avid Artist DNxIV
2133Mhz DDR4, Memory, thunderbolt 3 Mojo DX
Lenovo P50 2.6 Ghz or higher quad core Nvidia M1000M,  Avid Artist DNxXIO
17/Xeon E3 1920x1080 or 3840x2160 - 8 to 64 M2000M Avid Artist DNxIQ
GB 2133Mhz DDR4 Memory, thunderbolt 3 Avid Artist DNxIV
Mojo DX

HP Zbook 17" G2 - 2.5 Ghz and higher quad ~ Nvidia K3100M Avid Artist DNxIO
core i7 1920x1080 - 8/16/32 GB 1600Mhz K4100M, K2200M  Avid Artist DNxIQ

DDR3 Memory thunderbolt Avid Artist DNxIV
Mojo DX

HP Zbook 15" G2 - 2.5 Ghz and higher quad ~ Nvidia K1100M,  Avid Artist DNXIO

core 17 1920x1080 or 3200x1800 screen K2100M Avid Artist DNxIQ

resolution 8/16/32 GB 1600Mhz DDR3L Avid Artist DNxIV

Memory Thunderbolt Mojo DX

Dell M6800 17" 2.5 Ghz and higher quad core  Nvidia K2200M, Software Only
17 1920x1080 - 8/16/32 GB 1600Mhz DDR3  K3100M, K4100M Mojo DX
Memory K5100M

Dell M4800 15" 2.5 Ghz and higher quad core  Nvidia K1100M, Software Only
17 1920x1080 or 3200x1800 - 8/16/32 GB K2100M Mojo DX
1600Mhz DDR3 Memory
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Qualified PC Notebooks

Qualified Hardware and Operating Systems

Graphics Cards

Supported With

Dell M3800 15" 2.3 Ghz and higher quad core
17 1920x1080 8/16/32 GB 1600Mhz DDR3
Memory

Lenovo W541 15" 2.5 Ghz and higher quad
core i7 15" 1920x1080 2880x1620 - 8/16/32
GB 1600Mhz DDR3 Memory Thunderbolt

HP Zbook 17" 2.4 Ghz and higher quad core i7

1920x1080 - 8/16 GB 1600Mhz DDR3
Memory thunderbolt

HP Zbook 15" 2.4 Ghz and higher quad core i7
1920x1080 - 8/16 GB 1600Mhz DDR3
Memory thunderbolt

HP Zbook 14" 2.1 Ghz dual core i17-4600U
1920x1080 - 8/16 GB 1600Mhz DDR3L
Memory

Dell M6800 17 2.4 Ghz quad core i7 — Late
2014

1920x1080 screen resolution 8 or 16 GB
1600Mhz DDR3 Memory

Dell M4800 15" 2.4 Ghz quad core i7 — Late
2014 1920x1080 screen resolution 8 or 16 GB
1600Mhz DDR3 Memory

Dell M3800 15" - 2.2 Ghz quad core i7 - Late
2014 1920x1080 screen resolution 8 or 16 GB
1600Mhz DDR3 Memory

Lenovo W540 15" 2.4 Ghz and higher quad
core i7 15" 1920x1080 - 8/16 GB 1600Mhz
DDR3 Memory Thunderbolt

Nvidia K1100M

Nvidia K1100M,
K2100M

Nvidia K3100M,
K4100M

Nvidia K1100M,
K2100M

Intel HD4400

ATI FirePro M4100

Nvidia K3100M,
K4100M

Nvidia K1100M,
K2100M

Nvidia K1100M

Nvidia K1100M
K2100M

Avid Artist DNXIO
Avid Artist DNxIQ
Avid Artist DNxIV
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Mojo DX

Software Only
Mojo DX

Software Only
Mojo DX

Software Only

Software Only
Mojo DX

Software Only
Mojo DX

Software Only

Software Only
Mojo DX
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Qualified Hardware and Operating Systems

Qualified Macintosh Workstations for Avid Media Composer
The following Macintosh Workstations are qualified with the Avid Media Composer.

Avid Artist DNxIV requires a Thunderbolt 2 or 3 card. See details here.

Qualified Macintosh Hardware Graphics Cards Supported With

iMac Pro 5K 27" 3.2 Ghz i7 8§ core Radeon Pro Vega 56, Avid Artist DNXIO

3.0 Ghz i7 10 core 64 Avid Artist DNxIQ
2.5 Ghz i7 14 core Avid Artist DNxIV
2.3 Ghz i7 18 core Mojo DX

Late 2017 - 32 to 128GB 2666 Mhz DDR4
NOTE: 10Gb Ethernect requires Avid NEXIS
Pro client v2018.3.

iMac Retina 5K 27" 4.2 Ghz i7 Quad core ~ Radeon Pro 570, 575, Avid Artist DNxIO

. 580 Avid Artist DNxIQ
Mid 2017 - 4 GB 2400 Mhz DDR4
id2017-81064G 00 Mhz Avid Artist DNxIV

Mojo DX
iMac Retina 4K 21.5" 3.6 Ghz i7 Quad core Radeon Pro 555, 560 Avid Artist DNxIO

' Avid Artist DNxIQ
Mid 2017 - 2 GB 2400Mhz DDR4
id 2017 - 8 to 32 GB 2400Mhz Avid Artist DNxIV

Mojo DX

iMac Retina 5K 27" 4.0 Ghz i7 Quad core Radeon M390, M395, Avid Artist DNxIO

Late 2015 - 8/16/32 GB 1867Mhz DDR3 M395X Avid Artist DNxIQ
Avid Artist DNxIV
Mojo DX

iMac Retina 4K 21.5" 3.3 Ghz i7 Quad core Intel Iris Pro 6200 Avid Artist DNxIO

Late 2015 - 8/16/32 GB 1867Mhz DDR3 Avid Artist DNXIQ
Avid Artist DNxIV
Mojo DX

iMac Retina 5K 27" 4.0 Ghz i7 Quad core Radeon M290X, Avid Artist DNxIO

Late 2014 - 8/16/32 GB 1600Mhz DDR3 M295X Avid Artist DNxIQ
Avid Artist DNxIV
Mojo DX

iMac 27”7 3.2,3.4, GHzi5 or 3.5 i7 NVIDIA GeForce Software Only
Quad-core (Late 2013 Thunderbolt) GTX 775 Mojo DX

iMac 21.5” 2.9, GHz i5 or 3.1 i7 Quad-core = NVIDIA GeForce Software Only
(Late 2013 Thunderbolt) GTX 750 Mojo DX
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http://avid.force.com/pkb/articles/en_US/Compatibility/DX-DNxIO-connection-chart

Qualified Macintosh Hardware

Qualified Hardware and Operating Systems

Graphics Cards

Supported With

Mac Pro 6 core 3.5 Ghz, 8 core 3.0 Ghz, 12
core 2.7 (Late 2013) 16/32 GB 1866Mhz
DDR3 Memory Thunderbolt - no PCI-e slots

Mac Pro “Westmere” Two 2.66GHz 6-Core
Intel Xeon (12 cores)

Mac mini 2.3/2.6GHz quad core Intel i7

Dual AMD
FirePro D300, D500,
D700

ATI Radeon HD 5770

Intel HD 4000

Mojo DX

Nitris DX (no HD capture)

Artist DNxIO
Artist DNxIQ
Artist DNxIV

Software Only
Nitris DX
Mojo DX
Artist DNxIO

Software Only

The following Macintosh notebooks are qualified with the current editing applications. The

Qualified Macintosh Notebooks for Media Composer

following applies to the editing system when running on a laptop.

*  HD Capture on Macintosh notebooks is not supported

*  Playback in full quality 10 bit mode is not supported

Qualified Macintosh Notebook

Graphics Cards

Supported With

MacBook Pro 15" 2.8 Ghz and higher i7 quad
core Mid 2017 - Touch Bar & Thunderbolt 3
16 GB 2133Mhz

LPDDR3 Memory
Touch Bar not used by MC

MacBook Pro 15" 2.6 Ghz and higher i7 quad
core Late 2016 - Touch Bar & Thunderbolt 3
16 GB 2133Mhz DDR4 Memory

Touch Bar not used by MC

MacBook Pro 15" 2.2 Ghz and higher i7 quad
core Mid 2015

Retina & Thunderbolt 16 GB 1600Mhz
DDR3L Memory

MacBook Pro 15" 2.3 Ghz and higher i7 quad
core Retina Late 2013 and Mid 2014 8 or 16
GB 1600Mhz DDR3L Memory
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HD630
AMD
Radeon

Pro 555, 560

HD530
AMD
Radeon
450,455, 460

HD5000
AMD
Radeon
M370X

Nvidia

GeForce

GT 750M

& Intel HD5000

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Mojo DX



Feature Performance

Qualified Macintosh Notebook Graphics Cards Supported With
MacBook Air 13" - 1.7 Ghz and higher i7 dual Intel HD5000 Software Only
core

Mid 2013/Early 2014 - Thunderbolt - 8 GB

1600Mhz DDR3L

Feature Performance

A number of features in this editing application are processor-intensive. As a result, you might
experience problems if you are working on an older system. The following chart shows the
hardware that Avid has successfully qualified when using these features. For a list of the
qualified systems, see Qualified Workstations and Laptops.

Feature Description Recommended System

Editing High Resolution, 64 GB RAM minimum, 96 GB

High Frame Rate XAVC-I recommended Dell 7920
Media (UHD/4k in Dell 7820
59.94p)

* Dual Xeon Gold 6154 3.0 Ghz, turbo
up to 3.7 Ghz 18-core (72 cores with
Hyperthreading)

« AMD WX-7100
Storage: 10Gb Ethernet Avid NEXIS

4 streams of media and
color adapters

1080p/50 XAVC Long 16 GB RAM minimum Qualified PC Dual 6 Core or higher
Baseband Capture Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading
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Feature Performance

Feature Description

Recommended System

Editing High Resolution, 16 GB RAM minimum, 32 GB

High Frame Rate DNxHR recommended
Media (UHD/4k in
59.94p)

Editing High Resolution 16 GB RAM minimum

Media (Higher than 2K+)

DMF and Background

Render

Media Composer | Cloud 16GB RAM minimum. 24 GB or
higher recommended depending
upon system model.

J2K Capture

XDCAM Long GOP
9-way MultiCam with
high stream count
sequences

8 GB RAM minimum. 16 GB
Transcode, Background =~ RAM recommended

Avid recommends 16 GB RAM

28

HP 7840/7820

HP 7640/2620

Dell 7920/7910/ T7610
Dell 7820/7810/T5610
Lenovo P910/P900/
Lenovo P710/P700

+ NVIDIA P5000, M5000 or K5200
and AMD WX-7100
PCle Gen3 Gfx card (recommended)

Mac Pro

* 12 core (24 with Hyperthreading)
3 GHz

* Dual AMD FirePro 500/700 Graphics
card

Storage: 10Gb Ethernet Avid NEXIS

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

17 Quad core or higher with
Hyperthreading

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Storage: 10Gb Ethernet ISIS



Feature Performance

Feature

Description

Recommended System

Stereoscopic 3D

XDCAM HD50 Capture

HD RGB 4444
Apple ProRes 4444
DNxHD 4444

AMA (RED)

AMA (QuickTime)

AVCl-Intra Capture

For optimal performance with
Stereoscopic 3D, use these higher
performance systems. Avid
recommends a minimum of 12GB
RAM when using Stereoscopic
3D.

Baseband capture through Nitris
DX, Mojo DX

HD RGB capture requires a high
end workstation with Nitris DX
and fast storage.

AMA is a processor intensive
operation. Older platforms may
not offer optimum performance.
you will get better performance
with higher end workstations.

AMA is a processor intensive
operation. Lower end platforms
may not offer optimum
performance. Highly compressed
codecs such as H.264 will exhibit
minimal real-time performance.

AVC-Intra capture with software
codecs is supported.
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Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Qualified systems

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Storage: 10Gb Ethernet ISIS

Qualified Xeon Workstations

NOTE: RED plug-in uses the Graphics
Processor. Better performance with high
performance graphics cards.

Recommendation of qualified systems
depends on your planned use of this
feature. Heavy usage of highly
compressed codecs requires the high end
systems. (Dual 6 Core or Dual 8 Core
systems)

24 core and higher Windows systems
only.

Note: If problems are encountered, please
use a Nitris DX w/AVC-I capabilities or
ingest at another resolution like DNxHD
and transcode to AVC L.



Compatibility Chart

Feature Description Recommended System

AVCl-Intra AVC-Intra(AVC-I) is a high 4-Way MultiCam Playback

Fluahty’ low p1t—rat§ HD codecand Dual Quad Core, Dual 6 Core or Dual 8
is very CPU intensive. C
ore Systems

Four Stream Playback:

Dual Quad Core, Dual 6 Core or Dual 8
Core Systems

AMA Workflows: Dual Quad, Dual 6 or
Dual 8 core systems

Compatibility Chart

The following table lists the NVIDIA® driver, QuickTime®, Windows Media™, shared storage,
Sony® XDCAM™, Panasonic® P2, and Avid Artist Series versions that were qualified with the
Avid editing applications.

IMPORTANT: For information on third party support (for example, Sorenson, Boris,
etc) see the third party’s web site.

Item Versions Comments

QuickTime Support  v7.7.9 (Windows) Note: QuickTime v10X does not include
v10.x, (v7.x legacy) (Macintosh) QuickTime Pro options.

Note: QuickTime is not supported with

Windows 10.
Windows Media Windows Media Player 12 (for ~ If you do not have Windows Media
Version Support Windows 7) Player, access the download at

www.microsoft.com.

Windows Media export compatibility is
subject to Microsoft Windows Media
updates.
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http://www.microsoft.com/en/us/default.aspx

Compatibility Chart

Item Versions Comments
Avid Interplay See Knowledge Base articleon =~ IMPORTANT: The Avid Interplay
Support compatibility. components that get installed on the

editing application must be updated to
the Avid Interplay version that is released
with the editing application. These
include the Media Indexer, Interplay
Access, Interplay Framework, Interplay
Transfer Client and ProEncode Client.
The Avid Interplay Server components
can remain on the previous releases listed
as supported. For details, see the “Avid
Editing Application Compatibility with
Interplay Releases” doc on the

Knowledge Base.
NVIDIA Driver v390.77 See “Setting up the NVIDIA Card” on
Support page 36.

For setting up the driver for stereoscopic,
see the NVIDIA setup info in the
Stereoscopic 3D Workflow Guide.

Shared Storage Avid NEXIS and Avid ISIS®. See “Shared Storage Support” on
Support page 37.
Sony XDCAM driver v2.13 (XDCAM Transfer for The VFAM firmware version for
Macintosh) PDW-U1 is 2.600.
Windows FAM v2.3.2and VFAM  Lh¢ PDW-U2 is 2.810.

The driver can be downloaded from

va.0.2 Sony's website http://esupport.sony.com/.
Panasonic P2 drive (Macintosh) v3.1.7 There is currently no P2 writeback
(Windows) v2.24 support for Macintosh clients.
Avid Artist Series EuControl software v3.4 See the User’s Guide for information on
(Euphonix) Artist Series Color setup information.
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Avid Editing Application Compatibility with Pro Tools

Avid Editing Application Compatibility with
Pro Tools

General Co-Installation Notes:

Install Pro Tools first and then Media Composer.

You must uninstall all older versions of Media Composer or Pro Tools before installing
newer versions.

Co-install does not support both applications launched simultaneously.

When you uninstall Pro Tools, choose to uninstall just the application and not the audio
drivers or the editing application no longer sees the devices. On a Macintosh Pro Tools 10
system, this is named the “Safe Uninstall.” On a Macintosh Pro Tools 11 system no
uninstallation is required. On a Windows Pro Tools 10 or 11 system, you must select the first
uninstall option - “Pro Tools Only” - which is not selected by default.

Mojo SDI will not be supported with Media Composer or Pro Tools 11, but can still be
connected in a co-install configuration for use with Pro Tools 10.

If you install and configure Avid Mojo DX or Nitris DX hardware on your system, the
editing application does not use any connected Pro Tools audio device for audio input/output
operations. You can also use these audio devices with a software-only version of your Avid
editing application.

If you run into any issues, uninstall both applications and reinstall Pro Tools first, and then
reinstall your editing application.

Media Composer v5.0 and later and Pro Tools v8.0.3 and later do not include support for the
Original Mbox. If you want to use the Original Mbox, you should use Media Composer v4.x
and Pro Tools v8.0.1 instead.

If you want to install your Avid editing application on a system with the Pro Tools Avid
Video Engine installed, you must use one of the following configurations:

- Media Composer v5.5/NewsCutter v9.5 and later with Pro Tools v9.0 or later.

- Media Composer v5.0.x/NewsCutter v9.0.x with Pro Tools v8.5 or earlier.
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Co-installation Configurations and Audio Device Support

Co-installation Configurations and Audio Device
Support

Avid Pro Tools Applications

MC/NC MC/NC
Pro Tools Software with Mojo MC/NC/
Product Only DX with Nitris DX
Pro Tools Co-install Co-install Co-install

Software Only

Pro ToolsfHD  Co-install/ Co-install Co-install
Native Audio Device

Pro ToolsHD  Co-install/ Co-install Co-install
Audio Device

Pro Tools/HD, Not Tested  Not Tested  Not Tested
with chassis

Avid Mbox Family Audio Devices (3rd Generation)

Audio MC/NC

Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Mbox Co-install/ Co-install Co-install
(USB) Audio Device

Mbox Pro Co-install/ Co-install Co-install

Audio Device

Mbox Mini  Co-install/ Co-install Co-install
(USB) Audio Device

Avid Mbox 2 Family Audio Devices

Audio MC/NC

Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Mbox 2 Co-install/ Co-install Co-install
(USB) Audio Device
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External Controllers

Other Avid Audio Devices

Audio MC/NC
Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Mbox 2 Pro Co-install Co-install Co-install
(1394)
Mbox 2 Co-install/ Co-install Co-install
Mini (USB) Audio Device
Mbox 2 Co-install Co-install Not tested
Micro
(USB)
Audio MC/NC
Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Digi 002 Co-install/ Co-install Co-install
(1394) Audio Device

(Windows)
Digi 003 Co-install Co-install Co-install
(1394)
Eleven Rack Not Supported Not Supported Not Supported

(USB)

Fast Track  Audio Device Not Supported
Pro (USB)

Not Supported

External Controllers

Your Avid editing application supports the following external fader controllers or mixers for
automation gain and pan recording or as control surfaces:

*  Digi 002 (Windows only)
+ Command|8

*  Avid Artist Control

*  Avid Artist Mix
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External Controllers

*  Avid Artist Transport
*  Avid Artist Color

External controllers or mixers are optional. They are not required for you to perform automation
gain or pan recording on an Avid editing system.

The following table compares Avid external controllers and mixers.

Avid

Digi 002 Command| Artist Avid Avid Artist Avid Artist
Feature (MC only) 8 Control Artist Mix Transport Color
Control surface Yes Yes Yes Yes Yes
for transport (transport
controls and only, no soft
other functions keys)
Provides audio Yes No No No No
play, input, and
output
Record Yes Yes Yes Yes No
automation
gain
Record Yes Yes Yes Yes No
automation pan
Flying faders ~ Yes (8) Yes (8) Yes (4) Yes (8) No
Touch-sensitive Yes Yes Yes Yes No
faders
Touch-sensitive No No Yes Yes No
panners
Solo/mute Yes Yes Yes Yes No
Supports audio No? No No No No
mixing
Latch mode Yes Yes Yes Yes No
(also known as
Snap mode)
Number of 1024 1024 1024 1024 Not applicable
steps of fader
accuracy
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Setting up the NVIDIA Card

Avid
Digi 002 Command| Artist Avid Avid Artist  Avid Artist
Feature (MC only) 8 Control Artist Mix Transport Color

a. The Digi 002 can be used as a standalone audio mixer but not at the same time as it is being used as an automation gain or
automation pan controller or control surface.

For more information on using these external fader controllers or mixers, see “Recording
Automation Gain or Automation Pan Information” in the Help.

Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version
(install the display driver if necessary, and set the correct display settings. See the “Compatibility
Chart” on page 30 for information on the supported driver(s).

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver
version. If you do not have the correct NVIDIA driver, you can install it from the Utilities folder
that installs with your Avid application.

Installation files for these drivers are installed in the folder Program Files\Avid\Utilities\nVidia.
To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the Windows
Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information section on the ForceWare
version line.

To install the NVIDIA display driver:

1. Navigate to Program Files\Avid \Utilities \nVidia and double-click the folder that
corresponds to your operating system.

2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions, and then restart your system.

To setup multiple displays:
1. Right-click the Desktop, and select Nvidia Control Panel.
2. In the settings window in the left of the window, click Set up multiple displays.

3. Select or deselect the desired monitors listed.
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Shared Storage Support

To set the Driver for Avid Editing Environments

1.

A S

Right-click the Desktop, and select Nvidia Control Panel.

Click Manage 3D Settings.

Click the Global Setting tab.

Under Global presets, select Base Profile.

Scroll to locate the Power Management Mode. Select Prefer maximum performance.
Click Apply.

Reboot after installing the Nvidia software even if you are not prompted to do so.
Never use the Windows “roll back driver” feature on the Nvidia driver. The driver version must
match the rest of the components the Nvidia installer installs.

Shared Storage Support

For information on Shared Storage Support, see the Avid NEXIS and Avid ISIS tables in the
following document:

http://resources.avid.com/SupportFiles/Attachments/Interplay_MediaCentral_Support_Matrix.p

df
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Shared Storage Support

Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including
photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.

Copyright © 2018 Avid Technology, Inc. and its licensors. All rights reserved.
Portions © Copyright 2003-2007 of MOG Solutions.

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks

Avid, the Avid Logo, Avid Everywhere, Avid DNXHD, Avid DNXHR, Avid Nexis, AirSpeed, Eleven, EUCON, Interplay, INEWS, ISIS,
Mbox, MediaCentral, Media Composer, NewsCutter, Pro Tools, ProSet and RealSet, Maestro, PlayMaker, Sibelius, Symphony, and
all related product names and logos, are registered or unregistered trademarks of Avid Technology, Inc. in the United States and/or
other countries. The Interplay name is used with the permission of the Interplay Entertainment Corp. which bears no responsibility
for Avid products. All other trademarks are the property of their respective owners. For a full list of Avid trademarks, see:
http://www.avid.com/US/about-avid/legal-notices/trademarks.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or
other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows

is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other
trademarks contained herein are the property of their respective owners.

Avid Media Composer ReadMe + Created 5/17/18
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